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THE ENERGY CONSERVATORY, INC.  SOFTWARE PRODUCT LICENSE AGREEMENT
(appears during software installation)

This legal document is an agreement between the end user (hereinafter “Licensee”) and The Energy Conservatory, Inc. (hereinafter
"TEC").  This agreement constitutes the complete agreement between the licensee and TEC for this software program, which
includes computer software and may include associated media, printed materials and electronic documentation (hereinafter
“Software Product”) .

BY SELECTING THE YES BUTTON BELOW, YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT,
YOU UNDERSTAND IT AND YOU AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS, WHICH INCLUDE THE
SOFTWARE PRODUCT LICENSE, THE EXPRESS LIMITED WARRANTY AND THE LIMITATION OF WARRANTY
AND LIABILITY (Collectively the "Agreement").  THIS AGREEMENT APPLIES TO YOU AND ANY SUBSEQUENT
LICENSEE OF THIS SOFTWARE PRODUCT.

IF YOU DO NOT ACCEPT OR AGREE TO THE TERMS OF THIS AGREEMENT, PRESS THE NO BUTTON BELOW.

1.  THE ENERGY CONSERVATORY, INC. SOFTWARE PRODUCT LICENSE

A.  GRANT OF LICENSE.  TEC grants to licensee a non-exclusive right to use this copy of the Software Product on a single
computer at a single location.  This Software Product is licensed, not sold, to you by TEC and may be used, in object code form
only and only in conjunction with testing hardware and software programs authorized by TEC. You agree not to translate, reverse
engineer, reverse compile, disassemble or make derivative works from this Software Product.  You may neither sublicense the
Software Product, nor sublicense or assign the license granted under this agreement, without prior written authorization from TEC.
TEC reserves all rights not expressly granted to licensee.

B.  OWNERSHIP OF SOFTWARE.   TEC retains title and ownership of the Software Product.  This license is not a sale of the
original Software Product or any copy thereof.

C.  COPY RESTRICTIONS.   The Software Product and any accompanying documentation are copyrighted.  Unauthorized
copying of the Software Product, including software that has been modified, merged, or included with other software, or of any
accompanying documentation is expressly forbidden.

2.   EXPRESS LIMITED WARRANTY 

TEC warrants that the Software Product will perform substantially in accordance with the accompanying written materials for a
period of 90 days from the date of receipt by the licensee.

3. LIMITATION OF WARRANTY AND LIABILITY

The foregoing warranty is in lieu of all other warranties and is subject to the conditions and limitations stated herein.  TEC MAKES
NO WARRANTY OR REPRESENTATION, EITHER EXPRESSED OR IMPLIED, WITH RESPECT TO THIS SOFTWARE
PRODUCT, INCLUDING ITS QUALITY, RESULTS OBTAINED, PERFORMANCE, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE.

THE EXCLUSIVE REMEDY OF THE PURCHASER FOR ANY BREACH OF WARRANTY shall be the return of the Software
Product to TEC for replacement, or, at the option of TEC, refund of the purchase price.  

IN NO EVENT WILL TEC OR ITS DISTRIBUTORS OR AGENTS BE LIABLE FOR INDIRECT, SPECIAL, INCIDENTAL,
OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR THE INABILITY TO USE THE SOFTWARE
PRODUCT, even if advised of the possibility of such damages.  In particular, TEC is not responsible for any costs including, but
not limited to, those incurred as a result of lost profits or revenue, loss of the use of the software, loss of data, the cost of recovering
such software or data, the cost of substitute software, or the claims of third parties.  In any case, TEC’s maximum liability for any
and all losses, injuries or damages (regardless of whether such claims are based on contract, negligence, strict liability or other tort)
shall be the purchase price paid for the Software Product.

This limitation of Warranty and Liability may not be amended or modified, nor may any of its terms be waived except by a writing
signed by an authorized representative of TEC.
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TECBLAST is The Energy Conservatory’s duct airtightness test analysis program for Windows computers.
The TECBLAST program is used to calculate, display and store test results from duct airtightness tests
using a Minneapolis Duct Blaster®. 

TECBLAST Features

• Easy data entry of all test data, building and customer information.
• Calculation and display of duct airtightness test results including estimated leakage rate in CFM,

leakage area in square inches, leakage as a percent of system airflow, and estimated annual system
efficiency loss from duct leakage. 

• Built-in report generator includes a choice of one page easy-to-read homeowner report, or a two page
detailed technical report.   

• TECBLAST lets you print your company logo directly on the reports for a professional image.
Compatible with either BMP or EMF logo file formats.

• On-Screen Help.

Help Buttons

Each screen in the TECBLAST Program contains a Help button to provide you with  detailed information
for that screen. Wherever you see the Help button, clicking on it will open a text window. We recommend
that you use all the Help buttons the first time you run the program. Also, feel free to pick up the phone for
some assistance in getting started (612-827-1117). 

Installing TECBLAST for Windows

Before starting the install process, make sure you have at least 2 MB of hard drive space available. Place
the TECBLAST diskette or CD in the appropriate drive on your computer. From the Start button, open the
Control Panel.

From the Control Panel window, click on Add/Remove Programs and then click on Install.

The computer will locate the TECBLAST installation program on the floppy disk or
CD and guide you through the remainder of the installation process

Chapter 1    Introduction to TECBLAST  (Version 1.1 for Windows)
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Starting TECBLAST

The TECBLAST program should have been installed using the procedures outlined in Chapter 1
(Installing TECBLAST for Windows).  

To start TECBLAST, click on  Start...Programs...Energy Conservatory...TECBLAST 1.1.   

The main TECBLAST screen will now appear, with the Main Menu containing File, Options, Goto and
Help located in the upper left hand corner.

Figure 2.1:  Main TECBLAST Screen 

Chapter 2    Starting the TECBLAST Program
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Starting a New Test

To start using the TECBLAST program, open the File Menu by clicking on File in the Main Menu. The
top of the File Menu contains three starting options:

⇒ New Test   is selected to begin data entry for a new duct airtightness test using the factory
default program settings. Selecting this option automatically loads all factory default settings
and takes you to the Customer and Building Info Screen.

⇒ New Test with Custom Configuration   is selected to begin data entry for a new duct
airtightness test using custom configuration files which you have previously created and
saved. Using configuration files is the most efficient way to run TECBLAST. Creating and
saving configuration files is discussed in Chapter 9. After selecting a configuration file to
load,  the Customer and Building Info Screen will appear.

⇒ Retrieve Existing Test   lets you recall a previously saved duct airtightness test file. After
selecting the test file to retrieve, the values from the retrieved file are loaded into the
program, and the Customer and Building Info Screen appears. Once a test file is recalled, it
may be viewed, edited and re-saved (with the same or a different file name).  Refer to
Chapter 7 for more information on retrieving and saving test files.

Menu choices are selected by clicking on the desired option. We recommend that first time users begin by
selecting New Test. The other starting options should be explored after familiarizing yourself with the
TECBLAST program.  

Help Buttons

Each screen has its own Help button (located in the upper right hand corner) which opens a Help window
providing useful operating tips and detailed explanations of what information needs to be entered into each
field. Be sure to use the Help feature the first time you use TECBLAST, and refer to the Help buttons
whenever you have a question on program operation. To close a Help window, click on Exit Help.
 

Input Screens

The first 2 pages of TECBLAST are input screens where you will enter information about the customer,
the building and duct system being tested, and any relevant comments that you would like to save along
with the test file. An overview of the 2 screens are shown on the next page. You can click on individual
fields to enter information, or use the Tab key to quickly move between fields. To clear a screen, click on
the Clear button at the bottom of each page. When you are finished with a screen, click on the Next button
to proceed. At any time, you can step back to earlier screens by using the Previous button, or use the Goto
Menu to move to any active screen.

Chapter 3    Overview of TECBLAST
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 Customer, Building and Comment Screens

Test Settings, Graph and Manual Data Entry Screens

After completing the Comments Screen, click on Next to move to the Test Settings Screen:

Customer and Building Info Screen:
   The Customer and Building Info Screen is
   used to input the name, address, and phone
   number of the customer for whom the
   duct test is being performed. In
   addition, a second set of building address
   fields can be filled in if the building address
  is different from the customer address.

Test Settings Screen:
   The Test Settings Screen is used to set the
   Test Mode, Test Pressure and Test Type, as
   well as edit the Duct System Parameters.
   Click on Next to move the Test Graph
   Screen.

Comments Screen:
   The Comments Screen is used to enter an
   unlimited number of lines of comments on
   the duct system and building being tested.
   Comments are stored along with the test file
   and are printed out as part of the Detailed
   Report.
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Test Results Screen

Duct Leakage Test Graph:
   Test data entered into the Data Table are
   displayed on this screen. To begin entering
   data, click on the Data Table button.

Data Table (Total Leakage Test):
   The Data Table is used to input duct
   test readings (i.e. duct pressure and fan flow
   data). The Data Table for the Total Leakage
   test will allow entry of up to 10 sets of  test
   readings, plus one pre-test and one post-test
   baseline duct pressure reading. The inclusion
   of baseline readings in the table allows for
   quick adjustments to entered test readings for
   baseline stack and wind effects. After you have
   entered all data into the table, click on OK to
   return to the Test Graph.

Test Results:
  To look at the calculated test results, click on
  Next from the Test Graph Screen. Test results
  are automatically calculated using all data points
  displayed on the graph, and values input into
  the Building and Test Settings Screens.
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Using the Goto Menu

The Goto item in the Main Menu allows you to quickly move to any active screen within the TECBLAST
program. Clicking on Goto will bring up the following dialogue box. 

Simply click on one of the active choices to immediately move to that screen.
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Customer and Building Information Screen

The Customer and Building Information Screen is used to input the name, address and phone number of
the customer for whom the duct leakage test is being conducted. You may also input the name of the
technician performing the test. In addition, fill in the separate building address fields if the address of the
building being tested is different from the customer address. All information entered on this screen is
stored in both test and configuration files.
   
The Customer and Building Information Screen contains two additional fields, Building Floor Area and
Air Handler Flow: 
  
Building Floor Area:    Enter the floor area of the building in square feet.  Include all floors in
intentionally conditioned spaces. If you enter a value of 0 (or leave the field blank), Duct Leakage as a
Percent of Floor Area will not be calculated.

Air Handler Flow:    Enter the estimated total system airflow (in CFM) of the air handler connected to the
duct system being tested. Air handler flow can be estimated from the air handler nameplate, using the fan
curve and a measurement of the total static pressure, or by directly measuring the airflow using a
reasonable flow measuring technique (e.g.  Duct Blaster pressure matching method, temperature rise
method, TrueFlow plates etc.). For multiple speed systems, use the lowest fan speed unless directed
otherwise. If you enter a value of 0 (or leave the field blank), Duct Leakage as a Percent of  System
Airflow and the Estimated Annual Efficiency Loss from Duct Leakage will not be calculated.

You can click on individual fields to enter information, or use the Tab key to quickly move between fields.
To clear the Customer and Building Information Screen, click on the Clear button. When you are finished
entering information, click on Next to move to the Comment Screen.

Figure 4.1:  Customer and Building Information Screen

Chapter 4    Editing the Input and Test Settings Screens
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Comments Screen

The Comment Screen can be used to enter an unlimited number of lines of comments on the building and
duct system being tested. Comments are saved along with the duct leakage test file and can be printed out
as part of the detailed test report. Typical comments entered on this screen include client interview
information, building and duct system conditions during the test, the location of major air leakage sites  etc.
To clear the Comments Screen, click on the Clear button. When you are finished entering comments, click
on Next to move to the Test Settings Screen, or Previous to move back to the Customer and Building
Information Screen.

Note:  You can access standard Windows copy and paste commands within the Comments Screen by
clicking on the right mouse button. This allows you to easily move text between TECBLAST and other
Windows programs such as Microsoft Word.  

Test Settings Screen

The Test Settings Screen is used to set up the duct leakage test procedures to be used by the TECBLAST
program. You can click on individual fields to enter information, or use the Tab key to quickly move
between fields. When you are finished selecting test settings, click on Next to move to the Test Graph
Screen(s), or Previous  to move back to the Comments Screen.

Figure 4.2:  Test Settings Screen

Test Mode  

Click on Pressurize if the Duct Blaster fan will be blowing air into the duct system, or select Depressurize
if the Duct Blaster fan will be sucking air out of the duct system.
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Test Pressure   

Choose a target test pressure of either 25 Pascals (0.1 inches of water column), or 50 Pascals (0.2 inches
of water column). Choose the Test Pressure that best estimates the average operating pressure in the duct
system, or the Test Pressure specified in the testing procedures you are following. The Test Pressure is the
pressure in the duct system at which the leakage rate will be measured. Most residential duct testing
programs in the United States specify a test pressure of 25 Pascals. 

Test Type (select from one of 2 options)

Total Leakage (Duct Blaster Only):   Select the Total Leakage (Duct Blaster Only) test if you are using
the Duct Blaster by itself to measure all leaks in the duct system, including both leaks to the outside as well
as leaks to the inside of the house. 

Outside Leakage (Combined Duct Blaster and Blower Door):   This test is selected when you are
measuring duct leakage to the outside only, using a test procedure which combines simultaneous operation
of a Duct Blaster and Blower Door system. This procedure attempts to eliminate air flow between duct
leaks and the inside of the building during the test by equalizing the pressure between the duct system and
the building. See your Duct Blaster Operation Manual for more information on this test option. 

Using the Edit Duct System Parameters button

The Duct System Parameters are used by TECBLAST when it calculates the estimated annual system
efficiency loss from duct leakage. If you do not wish to estimate an annual system efficiency loss, proceed
directly to the Duct Leakage Test Graph Screen by clicking on the Next button. To access the parameters,
click on the Edit Duct System Parameters button located at the bottom of the Test Settings Screen. 

Figure 4.3:  Duct System Parameters Screen
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When first viewing the Duct System Parameters Screen during a new test, all fields are blank. To enter
values into each of the fields, you can select the Use Default Values button, or you can click or Tab
through the individual fields to enter the information manually. If any of the fields are left blank, the
estimated annual system efficiency loss will not be calculated.

Percentage of Measured Leakage Connected to Outside:   When calculating an estimated annual system
efficiency loss, TECBLAST considers only outside duct leakage in its estimation model. Enter your best
guess as to what percentage of the measured duct leakage is escaping to, or being drawn from, outside the
conditioned space of the house. The percentage entered is multiplied by the total measured duct leakage to
determine the outside duct leakage rate for the estimation model.  Note: The default value for this field is
100 percent. In addition, if the Test Type chosen is Outside Leakage (Combined Duct Blaster and
Blower Door), this field is fixed at 100%.  

TECBLAST uses only outside duct leakage in its estimation model because outside leaks have the largest
impact on HVAC system performance. In addition, most residential duct leakage research studies
conducted in the U.S. have been performed on houses which contain significant portions of the duct
systems in unconditioned zones (e.g. attics, crawlspaces, garages).  Much less in known about the system
efficiency impacts of duct leakage within the conditioned space of the house.

Average Supply and Return Operating Pressures:   Enter your best estimate of the average pressure
seen by the majority of the duct leaks in the system under normal operating conditions. Input a separate
value for the supply side and return side of the system.  Note: The default value for these two fields is
either 25 Pascals or 50 Pascals, depending on the Test Pressure chosen from the Test Setting Screen.    

In order to estimate the impact of duct leakage on the annual system efficiency, we need to make an
assumption about the typical pressures acting on these leaks during normal operation. Typically, we
assume that the average operating pressure acting on the leaks is the same as the Test Pressure under which
the duct leakage test was conducted. TECBLAST allows the user to choose a Test Pressure of either 25
Pascals (0.10  inches of water) or 50 Pascals (0.20 inches of water) on the Test Setting Screen. This
assumption can be modified if you have evidence to suggest that a different operating pressure better
represents the pressure seen by the predominant duct leaks during normal operation.   

For example, if the majority of leaks in the supply duct system are at register boot connections, it might be
reasonable to assume that the average operating pressure for the supply leaks is less than 25 Pascals (e.g.
10 or 15 Pascals). If the majority of supply leaks are located at a high pressure location such as a supply
plenum, then it might be reasonable to assume that the average pressure seen by the supply leaks is larger
than 25 Pascals. 

Supply and Return Leakage Splits:   The Supply and Return Leakage Splits are the percentage of the
measured leakage which is located in that side of the duct system. For example, a Supply Leakage Split of
50 percent means that 50 percent of the measured leakage is in the supply side of the duct system.  Input a
separate value for the supply side and return side of the system.  Note: The default values for the Leakage
Splits are both 50 percent, meaning that the leakage is divided evenly between the supply and return
ductwork.

If you have measured either side of the duct system directly, or have other evidence to suggest that more or
less of the measured leakage is in one side of the system, then adjust the Split values accordingly. The
Leakage Splits, when added together, should always equal 100 percent.  
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Leakage Penalties:   The Leakage Penalties represent the effective annual energy penalty to the HVAC
system for each percent of supply and return air flow that is attributed to leaks. Input a separate value for
the supply side and return side of the system.

⇒ Supply Leakage Penalty: The default value for the Supply Leakage Penalty is 1.0. A default
value of 1.0 means that a measured supply leakage rate of 1 percent (i.e. 1 percent of system
airflow)  contributes to a 1 percent annual loss to the HVAC system. The default of 1.0
assumes that supply side leaks are direct losses to the outside and are not recaptured back to
the house. This number can be adjusted downward to reflect regain of usable energy to the
house from duct leaks.  For example, during the winter some of the energy lost from supply
leaks in a crawlspace will probably be regained back to the house (sometimes one-half or
more may be regained). In this case, a Supply Leakage Penalty of less than 1.0 may be
appropriate.

⇒ Return Leakage Penalty:  The default value for the Return Leakage Penalty is 0.5. A default
value of 0.5 means that a measured return leakage rate of 1 percent (i.e. 1 percent of system
airflow) contributes to a 0.5 percent annual loss to the HVAC system. The default value of
0.5 suggests that on average, return leaks contribute less to energy losses than do supply leaks
(which have a default Penalty of 1.0). The Return Leakage Penalty can be adjusted upward
from the default value if you have reason to suspect that the measured return leaks contribute
significantly more energy loss than on average (e.g. pulling return air from a super heated
attic),  or can be adjusted downward to represent significantly less energy loss (e.g. pulling
return air from a moderate temperature crawl space).
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Overview of Duct Leakage Test Graph Screen

Duct test data are entered and displayed from the Duct Leakage Test Graph Screen. The main feature of the
Test Graph Screen is a plot of Duct Blaster fan flow (or duct leakage) on the vertical axis versus duct
system pressure on the horizontal axis. Test data entered into the Data Table are plotted on the graph, and a
best-fit regression line is automatically drawn through the plotted data points.

Figure 5.1:  Duct Leakage Test Graph Screen

Selecting the Fan Model

Before entering data into the Data Table, select the Duct Blaster fan model being used for the test. To
select the fan model, click on Options located in the Main TECBLAST Menu. From the Options Menu,
select Fan Info. In the Fan Information window, select the appropriate fan model (or type), and then click
on OK. You may also input a fan serial number which will be stored along with the duct leakage test file,
and is printed out on the detailed test report. Importantly, if you change the selected fan model while test
data are displayed on the graph, the test data will be automatically cleared from the graph and the Data
Table.  

Note: The Series A Duct Blaster fan has a white fiberglass fan housing and the Series B fan has a black
urethane fan housing.
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Figure 5.2:  Fan Information Window

Entering Test Data into the Data Table

To manually enter test data, first click on the Data Table button from the Test Graph Screen. One of two
Data Tables will appear, depending on which Test Type has been selected in the Test Settings Screen. You
can move through the Tables using the Tab key, or by clicking on the individual entry fields.

If “Total Leakage (Duct Blaster Only)” is Selected

The Total Leakage Data Table allows entry of up to 10 sets of duct test readings (arranged in rows), plus
one Pre-Test Baseline reading, and one Post-Test Baseline reading.

Figure 5.3:  Total Leakage Data Table (Duct Blaster Only)
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To begin data entry, you must first input a Pre-Test Baseline reading in Pa. The baseline duct pressure is
the pressure between the duct system and the house before the Duct Blaster fan is turned on. The use of
baseline duct pressure readings in the Table allows TECBLAST to quickly adjust the test data for any
existing duct pressure caused by stack and wind effects.  

Note: In many cases, the baseline duct pressure will be very small and you can simply enter 0 into the Pre-
Test Baseline field. In addition, if you are using a DG-700 gauge and using the BASELINE feature,
always enter 0 into this field.

After entering the Pre-Test Baseline reading, enter the test readings. You may input as few as 1 and as
many as 10 sets of test readings. For each set of test readings, you must enter the measured duct pressure
(in Pa), the fan configuration corresponding to this set of readings (i.e. which flow ring was installed on the
fan), and the measured Duct Blaster fan flow used to generate the duct pressure. Fan flow can either be
entered directly in CFM (by choosing the Flow button in the Flow Data Source field), or by entering the
fan pressure signal in Pascals (by choosing the Fan Pressure button in the Flow Data Source field). If you
enter the fan pressure signal, the flow value will be automatically determined by TECBLAST.

If you input fewer than 10 sets of readings, simply leave the remaining rows empty. The Post-Test Baseline
reading is an optional field for those who wish to take a second baseline duct pressure reading following
completion of the duct test. If you input a Post-Test Baseline reading, the program will use the average of
the Pre and Post Baseline readings in its analysis. If you leave the Post-Test Baseline reading field empty,
the program will simply use the Pre-Test reading when adjusting for baseline duct pressure effects.

When you are finished entering test data into the Table, click on OK to return to the Test Graph. You can
clear the Table at any time by clicking on the Clear Data button.
 
Tips on Using a DG-700 Gauge with the Total Leakage Data Table:

⇒ Be sure you have the gauge set up properly (refer to your Duct Blaster or digital gauge
manual). If you have set the gauge up properly, duct pressure readings will be read from
Channel A, and Duct Blaster fan flow readings will be read from Channel B.

⇒ If you are using the DG-700’s BASELINE feature, always enter 0 into the Pre-Test Baseline
fields and leave the Post-Test Baseline field blank. Also enter 0 into the Pre-Test Baseline
field if you do not take a baseline reading.

⇒ If you are using the DG-700’s PR/  FL@25 feature to conduct a one-point Total Leakage
test, always enter the duct pressure as 25 Pa. This is because the @25 feature automatically
adjusts the displayed flow reading to a test pressure of 25 Pa.

⇒ If you are Depressurizing the duct system, enter the duct pressure readings as negative
numbers (TECBLAST automatically places a negative sign in the duct pressure entry fields if
the Test Mode is set to Depressurize).

⇒ If you are Pressurizing the duct system, enter the duct pressure readings as positive numbers.
⇒ Fan pressure readings can be entered as positive or negative numbers.
⇒ If you choose to take and enter a Post-Test Baseline reading, be sure to include the proper

sign of the reading.



Chapter 5   Entering Duct Leakage Test Data

15

Tips on Using a DG-3 Gauge with the Total Leakage Data Table:

⇒ Be sure you have the gauge set up properly (refer to your Duct Blaster or digital gauge
manual). If you have set the gauge up properly, duct pressure readings will be read from
Channel A, and fan flow (or fan pressure) readings will be read from Channel B. 

⇒ Be sure the Channel knob is pointing to the correct Channel when taking readings.
⇒ If you take and enter a Pre-Test baseline duct pressure reading, be sure to include the proper

sign of the reading. Enter 0 into the Pre-Test Baseline field if you do not take a baseline
reading.

⇒ If you are Depressurizing the duct system, enter the duct pressure readings as negative
numbers (TECBLAST automatically places a negative sign in the duct pressure entry fields if
the Test Mode is set to Depressurize).

⇒ If you are Pressurizing the duct system, enter the duct pressure readings as positive numbers.
⇒ Fan pressure readings can be entered as positive or negative numbers.
⇒ If you choose to take and enter a Post-Test baseline reading, be sure to enter the proper sign

of the reading

If “(Outside Leakage (Combined Duct Blaster and Blower Door)” is Selected

The Outside Leakage Data Table allows for entry of a single set of test readings. The Outside Leakage test
measures duct leakage to the outside of the building envelope only, using a procedure which combines
simultaneous operation of the Duct Blaster and Blower Door systems. This procedure attempts to eliminate
leaks between the duct system and the inside of the building by equalizing the pressure between the duct
system and the building. When using this procedure, there are no baseline pressure readings to enter.

Figure 5.4:  Data Table for Outside Leakage (Combined Duct Blaster and Blower Door)

For this test procedure, the duct pressure is adjusted at the Blower Door and is determined by measuring
either:

⇒ Building pressure with respect to Outside, or
⇒ Building pressure with respect to the space where the ducts are located.
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The Blower Door fan should be adjusted to achieve a building pressure equal to the Test Pressure selected
in the Test Settings Screen (e.g.  25 or 50 Pascals). Enter the measured building pressure (from the Blower
Door) into the Duct Pressure field in the Table. 

Note: If you are depressurizing the building and duct system, enter the duct pressure reading as a negative
number (TECBLAST automatically places a negative sign in the duct pressure entry field when the Test
Mode is set to Depressurize).

While the Blower Door is running, the Duct Blaster fan is used to equalize (or zero out) the pressure
between the duct system and the building. The fan configuration and fan flow (or fan pressure) needed to
create zero pressure difference between the duct system and the building (while the Blower Door is
running) should be entered into the remaining fields in the Table.

Fan flow can either be entered directly in CFM (by choosing the Flow button in the Flow Data Source
field), or by entering the fan pressure signal in Pascals (by choosing theFan Pressure button in the Flow
Data Source field). If you enter the fan pressure signal, the flow value will be automatically determined by
TECBLAST
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Once the test data have been manually entered into the Data Table, test results are automatically calculated
using all data points displayed on the graph, and values input into the building and duct system parameter
fields. To view the Test Results Screen, click on Next from the Test Graph Screen.

Figure 6.1:  Test Results Screen 

Overview of Test Results Screen

Measured Duct Leakage 
     
Test Type:   This is the Test Type selected on the Test Settings Screen.   
      
Test Pressure:   This is the Test Pressure selected from the Test Settings Screen. The Test Pressure is the
pressure in the duct system at which the duct leakage rate was measured.

Leakage Rate:   This is the measured duct leakage (in Cubic Feet per Minute) at the specified Test
Pressure.

Leakage Area:   Once you have quantified the leakage rate, it is possible to calculate a Leakage Area of
the duct system in square inches. The Leakage Area estimate is a useful way to visualize the physical size
of all cumulative leaks in the duct system. The Leakage Area is defined in TECBLAST as the size of a
sharp edged orifice which would leak at the same flow rate as the measured leakage, if the orifice were
subjected to the Test Pressure.

⇒ Leakage Area (sq in)  =        Duct System Leakage Rate (CFM)
         -----------------------------------------

1.06 x (Test Pressure)^0.5

Chapter 6    Viewing Test Results
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Leakage Parameters 

Leakage as a Percent of System Airflow:   This is the measured duct leakage rate, divided by the Air
Handler Flow entered in the Customer and Building Info Screen.

⇒ Leakage as % of System Flow = (Leakage Rate (CFM) / Air Handler Flow (CFM)) x 100

Leakage as a Percent of Floor Area:   This is the measured duct leakage rate, divided by the Building
Floor Area entered in the Customer and Building Info Screen.

⇒ Leakage as % of Floor Area = (Leakage Rate (CFM) / Floor Area (sq ft)) x 100 

Annual System Efficiency Loss:   TECBLAST uses a simple model for estimating an annual HVAC
system efficiency loss from the measured duct leakage rate. The annual loss estimate can be applied
separately to both heating and cooling modes of operation. The loss estimate uses the measured leakage
rate, entered Duct System Parameters from the Test Settings Screen, along with a number of assumptions
about the operating characteristics of the HVAC system. Refer to Appendix E in the Duct Blaster
Operation Manual for more information on how this estimate is calculated.

Notes on Estimated Annual System Efficiency Loss:

⇒ Because duct leakage loss calculations are extremely complex, this estimation technique
should be used with caution and should be viewed only as a rough estimate of the magnitude
of losses possible.   

⇒ The duct leakage loss estimates do not include many important but complex impacts on
system efficiency including latent load impacts, heat pump strip heating impacts, conduction
losses, increases in infiltration from dominant duct leakage, or interactions of leakage on
mechanical operating efficiencies, all of which can be significant depending on the type and
location of the system being tested. 

⇒ We do not recommend that this simple model be used for research purposes, program design
studies or program impact evaluations. More sophisticated duct leakage loss models are
available and better suited to those needs. Listed below are three references to other duct
leakage loss models:

ASHRAE Standard 152-2004,  Method of Test for Determining the Design and Seasonal
Efficiencies of Residential Thermal Distribution Systems,  ASHRAE, Atlanta GA,
December 2004.

“Development of a Practical Method for Estimating the Thermal Efficiency of
Residential Forced-Air Distribution Systems’,  EPRI,  Palo Alto CA,  January 1997.

“Improvements to ASHRAE Standard 152P”,  Paul Francisco and Larry Palmiter,
Ecotope,  Seattle WA,  June 1999.
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Leakage Split

Supply Side:   This is the estimated amount of leakage (expressed in CFM and square inches) in the
supply side of the duct system. The supply side leakage is calculated by multiplying the measured total
duct leakage rate and leakage area by the Supply Leakage Split value entered in the Duct System
Parameters Screen.  

Return Side:   This is the estimated amount of leakage (expressed in CFM and square inches) in the return
side of the duct system. The return side leakage is calculated by multiplying the measured total duct
leakage rate and leakage area by the Return Leakage Split value entered in the Duct System Parameters
Screen.  

Duct Leakage Curve    
     
Flow Coefficient (C) and Exponent (n):   Once the test data has been entered into the Data Table and
plotted on the Test Graph, a "best-fit" regression line (called the Duct Leakage Curve) is drawn through the
plotted data.  The Duct Leakage Curve can be used to estimate the leakage rate of the duct system at any
pressure. If you conduct a single point test, TECBLAST assumes an exponent (n) of 0.60 in its calculation
procedures.     

The Duct Leakage Curve is defined by the variables Coefficient (C) and Exponent (n) in the following
equation:  

Q = C x P^n    
where:     
Q  is airflow into (or out of) the duct system (in CFM).     
C  is the Coefficient.     
P  is the pressure difference between inside and outside of the duct system     
n  is the Exponent.     

Correlation Coefficient:   The correlation coefficient is a measure of how well the collected test data fit
onto the "best-fit" Duct Leakage Curve. The closer all data points are to being exactly on the Duct Leakage
Curve, the larger the calculated correlation coefficient (note:  the largest possible value for the correlation
coefficient is 1.0). Under most operating conditions, the correlation coefficient will be at least 0.99 or
higher.     

Testing in very windy weather can sometimes cause the correlation coefficient to be less than 0.99. In this
case, you may want to repeat the test and increase the number of data points 
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Saving Duct Leakage Test Files

Test files can be saved at any time by selecting File from the Main TECBLAST Menu, and then clicking
on  Save Current Test File which appears in the File Menu.

Saved duct leakage test files contain all information entered into the Customer and Building Screen, the
Comment and Test Setting Screens, as well as all test data shown on the Graph. When saving a test file,
you will need to enter a file name in the file saving browser that appears on screen. You may also choose a
different destination folder for the saved file by clicking on the Save in window. Once you have chosen a
file name and destination, click on Save.

Figure 7.1:  File Saving Browser  

Note:  All duct leakage test files are automatically given a .dct extension.  

Retrieving Duct Leakage Test Files

To retrieve a previously saved duct leakage test file for viewing, editing or printing, first select File from
the Main TECBLAST Menu, and then click on Retrieve Existing Test which appears in the File Menu.

After selecting the “Retrieve” option, a file browser will appear on screen which lists all the duct leakage
(.dct) test files contained in the default folder. To select a file, click on the file name from the list and then
click on Open. Once the file has been selected, the file information is loaded into the TECBLAST program
and the Customer and Building Info Screen appears. To change the folder being listed, click on the Look
in window.

Chapter 7   Saving and Retrieving Duct Leakage Test Files
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Figure 7.2:  File Retrieving Browser 

Retrieving a Previous Test as the Starting Point for a New Test

If you want to repeat a test of a duct system that you have previously tested, it is very convenient to start by
retrieving the old test. Choose Retrieve Existing Test from the File menu and select the old duct leakage
test file. As you go through the data entry screens, check for any information that has changed since the old
test was performed.

The data on the graph can be cleared by clicking on the Clear Data button from the Data Table window.
Use of the Clear Data button will not affect the original duct leakage test file stored on your computer.
When you are done, save your new test using a new file name.

Format of Saved Building Test Files

All duct leakage test files (.dct) are space delimited ASCII text files. The format for saved test files is
shown in Figure 7.3 below.
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Figure 7.3:  Format of Saved Test Files

TECBLAST Version: 
Building_Address: 
Building_Address_Line2: 
Building_City: 
Building_State: 
Building_Zip: 
Floor:
System_Airflow:
Test_Date: 
Technician: 
Name: 
Address: 
Address_Line2: 
City: 
State: 
Zip: 
Phone: 
Fax:
Avg_Supply_Oper_Pressure:
Avg_Return_Oper_Pressure:
Supply_Leakage_Split: 
Return_Leakage_Split: 
Supply_Leakage_Penalty: 
Return_Leakage_Penalty: 
Percentage_Outside_Leakage: 
Business: 
B_Address: 
B_Address_Line2: 
B_City: 
B_State: 
B_Zip: 
B_Phone: 
B_Fax
Comments: 

Manual_Entry_Data_0: 
Manual_Entry_Data_1: 
Manual_Entry_Data_2: 
Manual_Entry_Data_3: 
Manual_Entry_Data_4: 
(repeats through Data_10) 
Build_Test_Mode: P
Duct_Reference_Pressure: 25
Duct_Test_Type: 1

Software Version

Comments

 Data Table Entries

Business Info

Customer and
Building Info

Test Settings

Duct System
Parameters
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Station_count: 
Complete_test: 
Data_pt_0: 
Data_pt_1: 
Data_pt_2: 
Data_pt_3:                                                           Test Data1

Data_pt_4: 
Data_pt_5:
(repeats through Data_pt_10) 
Duct_Leakage: 
Duct_Leakage_Error: 
Duct_Leakage_Area: 
Duct_Leakage_AsPercentOf_Floor_Area: 
Duct_Leakage_AsPercentOf_System_Airflow: 
Annual_Duct_System_Efficiency_Loss: 
Supply_Side_Leakage: 
Supply_Side_Leakage_Area: 
Return_Side_Leakage: 
Return_Side_Leakage_Area: 
C: 
C_err: 
n:  
n_err: 
r: 
Build_Fan_Model: 3
Fan_Calib_DBA_Ring0: 
Fan_Calib_DBA_Ring1: 
Fan_Calib_DBA_Ring2: 
Fan_Calib_DBA_Ring3: 
Fan_Calib_DBA_Ring4: 
Fan_Calib_DBA_Ring5: 
Fan_Calib_DBB_Ring0:             
Fan_Calib_DBB_Ring1: 
Fan_Calib_DBB_Ring2: 
Fan_Calib_DBB_Ring3: 
Fan_Calib_DBB_Ring4: 
Fan_Calib_DBB_Ring5: 

                                                
1   Columns from left to right:  Fan Configuration (-1 = baseline reading), Target Duct Pressure, Duct Pressure
Reading, Fan Pressure Reading, Calculated Flow in CFM, Standard Deviation of the Duct Pressure Reading, Standard
Deviation of the Fan Flow Reading.

Calculated Test Results

Fan Info
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Printing and Preview Options

Report printing and previewing options are available by clicking on File in the Main Menu.   

TECBLAST includes a choice of two pre-formatted reports; a one page Customer Report, and a 2 page
Detailed Report. In addition, the Test Graph can be printed separately.  Note:  The actual length of the
Detailed Report depends on the number of lines of comments entered, and the number of data points
collected during the test.  

The Customer Report contains the basic test results and a simplified description of how to interpret the test
results. Detailed Reports contain a complete listing of the duct leakage test data,  the test results, as well as
any comments input into the Comment Screen.

The Test Graph is similar to the graph of fan flow (or leakage) vs. duct pressure from the Test Graph
Screen. It can be used to visually estimate the relationship between duct leakage and duct pressure.

The printing and preview functions within TECBLAST utilize the Windows printer drivers and
configuration options currently installed in your computer. Windows printer setup options can be accessed
by clicking on   Start....Settings....Printers.  

Putting Your Business Name and Logo at the Top of the Reports

The name, address and phone number for your business can be placed at the top of the first page of all
printed reports by completing the Business Info window.  To access the Business Info window, click on
Options in the Main Menu, and then click on Business Info from the Options Menu. Information entered
in the Business Info window is saved as part of the data files.

Chapter 8    Printing Test Reports
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Figure 8.1:  Business Information Window

To insert a logo at the top of the printed reports, simply place an electronic image of your logo in the
working directory of the TECBLAST program. The image file must be named “reportlogo”, and the file
format must be either a Windows Bitmap File (.bmp extension)  or a Windows Enhanced Meta File (.emf
extension). The default working directory for TECBLAST is  C:/Program Files/Energy
Conservatory/TECBLAST 1.1. If you chose a custom install directory for TECBLAST during program
installation, you will need to place the image file in that directory.

If a reportlogo.bmp or reportlogo.emf file is found by TECBLAST, the image is automatically placed in
the upper left hand corner of the printed reports.  The image is placed in a  2” wide by 1” high box, and
TECBLAST sizes the image (using its saved aspect ratio) to maximize its size within the box.  Because
TECBLAST uses a 2” wide by 1” high image box, images saved with a 2 to 1 width to height ratio will
completely fill the image box.  Images saved with any other aspect ratio will only completely fill the image
box in one dimension. 

Figure 8.2:  Top of Customer Report with Business Name and Logo

Figure 8.3:  Sample Customer Report (without logo)
Logo Image Box

DUCT LEAKAGE TEST RESULTS
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Figure 8.3:  Sample Customer Report (without Logo)
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Figure 8.4:   Sample Detailed Report (without logo)
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The Data Page table contains the following information:
  
 Duct Pressure:  The duct pressure reading at which leakage measurements were conducted, including the

pre and post test baseline measurements. Baseline duct pressure measurements correspond to Fan
Pressure readings of “n/a”.  Duct pressure data in the table are not adjusted for measured baseline
pressures.

 
 Fan Pressure:  Fan pressure measurements for each duct pressure.   
 
 Fan Flow (CFM):  Calculated air flow (or leakage) through the Duct Blaster fan, based on the measured

fan pressure and the calibration formula for the fan. 
 
 % Error:  The % Error column is the % difference between the fan flow listed in the table and the flows

calculated by the computer using the “best fit” Duct Leakage Curve.
 
 Fan Configuration:  The configuration of the fan (i.e. which low-flow ring was installed) when the fan

pressure reading was collected.
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What is a Configuration File?

There can be a significant amount of data entry required in filling out all of the screens of TECBLAST. A
configuration file is a place to save test settings, customer and building information, and comments that
you routinely use so they can be quickly loaded into the program. The configuration file can then be used
as a shortcut for speeding up data entry for future tests.  A configuration file looks just like a duct leakage
test file, except that no test data (i.e. duct pressure and fan flow readings) are stored in configuration files.2

How to Create a Configuration File

Before creating a configuration file, first be sure to save any current test data loaded into TECBLAST by
using the Save Current Test File option from the File Menu.  

Now select the New Test option from the File Menu.  Proceed through the Customer and Building,
Comments, and Test Settings Screens, filling in only the information which will be always be the same for
your testing. For example, on the Customer and Building Info Screen you would not want to fill in the
customer name but you probably would fill out the technician name. If there are any “standard” comments
which you would like to have on all tests, type them in on the Comments Screen at this time. On the Test
Settings Screen, choose the settings you wish to save.  Finally, open the Business and Fan Info windows
(found in the Options Menu) and complete the appropriate fields. 

When you have finished entering information and settings that you wish to save, select Save
Configuration File from the File Menu.

When saving a configuration file, you will need to enter a file name in the file saving browser that appears
on screen. You may also choose a different destination folder for the saved file by clicking on the Save in
window.  Once you have chosen a configuration file name and destination, click on Save.

Note:  All configuration files created in TECBLAST are automatically given a .cfd extension.  

                                                
2  Information entered using the Options Menu (e.g.  Business and Fan Info Screens) are also stored when a
configuration file is created.
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Figure 9.1:  Configuration File Saving Browser

How to Use Configuration Files

To use a configuration file when conducting a new test, click on New Test with Custom Configuration
from the File Menu.

After selecting the “Custom Configuration” option, a file browser will appear on screen which lists all the
configuration (.cfd) files contained in the default folder. To select a file, click on the file name from the list
and then click on Open. Once the configuration file has been selected, the file information is loaded into
the TECBLAST program and the Customer and Building Info Screen appears. To change the folder being
listed, click on the Look in window.

Figure 9.2:  Configuration File Retrieving Browser
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After loading the selected configuration file, complete the remaining data entry fields and proceed with the
test. Importantly, you are not “locked into” the entries which were loaded from your configuration file.
You can always edit all data entry fields during the test.

Some users may wish to create custom configuration files for a variety of testing situations they frequently
encounter. For example, a user may have separate configuration files for each city where they frequently
test. Configurations can also be created which are specific to:

test location
duct system type
fan model and serial number
technician

Keep in mind that the Comments Screen can be a particularly useful part of custom configuration files by
containing “boiler plate” comments which you would like to print out (or edit) for all tests.

Note:   Because configuration files are so useful, we recommend that everyone create at least one
configuration file and call it “default”.  This file should contain your most frequently used settings and
information. When you start a new test using New Test with Custom Configuration, the program will
automatically highlight the default file (if it exists) in the file selection browser, so all you need to do is
click on Open.
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The TECBLAST program comes installed with factory default fan calibration parameters for both Series A
and B Duct Blaster fans.3  The fan calibration parameters are used by the program to convert the measured
fan pressure in Pascals to airflow in Cubic Feet per Minute.  

If your Duct Blaster fan was custom calibrated by The Energy Conservatory, you can input your custom
calibration parameters directly into the TECBLAST program in lieu of the factory default values. To enter
custom fan calibration parameters, first open the Fan Information window by clicking on Options...Fan
Info from the Main TECBLAST Menu.

Figure 11.1:  Fan Information Window

From the Fan Information window, select the appropriate fan model, and then click on the Enter Custom
Calibration button to open the Fan Calibration Parameter Window.

Figure 11.2:  Fan Calibration Parameter Window

                                                
3   Series A Duct Blaster fans have a white fiberglass fan housing, and Series B fans have a black ABS fan housing.
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The Fan Calibration Parameter window shows the calibration parameters being used by the program for the
currently selected fan type. There is a unique set of parameters for each of the flow ring configurations
used with the fan. The individual calibration parameters can be selected for editing by using the Tab key,
or by clicking on the input fields.  Whenever you input a custom calibration parameter, the new value
shown in the field will be displayed in red, rather than black for the default values. You can easily return
all calibration parameters to the factory default values by clicking on Set to Defaults.  The currently
entered fan calibration parameters are stored as part of the data file.

Note:  Most users should never have to edit fan calibration parameters. The default fan calibration
parameters which come with the TECBLAST program should work fine for all standard Series A and B
Minneapolis Duct Blaster fans. This feature is necessary only if you receive custom calibration parameters
for your fan from The Energy Conservatory.




